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1 KONVENTIONEN IM HANDOUT 

1.1 AUSRICHTUNG DIESES HANDBUCHS 
Ziel dieses Manuals ist es, einen möglichst raschen Einstieg zur Verwendung der Visualisierungskomponente von 
Power BI Desktop zu liefern sowie einen möglichst umfassenden Überblick zu den verfügbaren Visualisierungs- und 
Analysefunktionen zu liefern: 
> Die detaillierte Beschreibung einzelner Funktionen sowie die inhaltliche Diskussion der Trainingscases ist zwar 

Bestandteil des Trainings sein, ist jedoch nicht der Anspruch dieses Manuals. 
> Das Manual ist – abgesehen vom Einstiegskapitel – streng modular nach Themenbereichen aufgebaut und bildet 

daher nicht den chronologischen Ablauf des Trainings ab (im Manual wird also keine durchgehende „Story“ erzählt). 
Dies deshalb, weil Power BI Desktop monatlich mit einem Release um neue Funktionen erweitert wird und die 
Inhalte des Manuals von Trainingstermin zu Trainingstermin sonst kaum zu warten wären.  

> Folgende angrenzende Themen werden bewußt nicht behandelt  
· Inhaltliche Gestaltung von Dashboards (Auswahl der KPIs, der Daten- und Wertkategorien, usw.) 
· Formale Gestaltung von Dashboards (Notationskonzept, UI-Konzept, usw.) 
· Advanced Analytics mit der R-Integration 
· Der Visualisierungskomponente von Power BI vorgelagerte Bausteine (Step-1 Queries, Step-2 Datamodel inkl. 

DAX) und nachgelagerte Bausteine (Step-4 Deployment, Step-5 Distribution/Consumption) 
 

1.2 POWER BI DESKTOP SPRACHVERSION UND RELEASESTAND 
Releasestand: April 2018 
Englische Programmversion: English 
Regional Settings (im Power BI File): German (Germany) 
 

1.3 ZENTRALE BEGRIFFE IN POWER BI 
Die folgende Liste dient zur raschen Orientierung, was die am häufigsten verwendeten Begriffe bedeuten.  
 

Komponente 
„Power BI 
Desktop“ 

Programm-Settings („Options & Settings“) 
PBIX-Datei = Anwendung 

Komponente 
„Get Data“ 

Datenquellen 
Queries 
M-Formeln 
Parameter und Funktionen 

Komponente 
„Datamodel“ 

Faktentabellen (Foreign Keys und Wertspalten) 
Dimensionstabellen (Primary Keys und Attribute) 
Beziehungen (unidirektional, bidirektional) 
DAX-Formeln für Measures, Calculated Columns und Calculated Tables 
Parameter und Parameter-Tables 

Komponente 
„Visualisierung“ 

Page = Canvas („weiße Fläche“) 
 
Feldliste („FIELDS“-Bereich des Datamodels) 
> Aktivieren eines Feldes = Häkchen in der Feldliste setzen oder Drag & Drop auf den F 
> Markieren eines Feldes / einer Tabelle = auf den Titel klicken 
> Kontextmenü des Feldes (in der Feldliste) 

Visual markieren 
> „Visual Header“ = Bearbeitungsrahmen 
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> „Ellipsis-Menü“ im Visual Header („More options“) 

 

Visual- und Page-Settings (bei aktiver Markierung) 
> Fields-Settings („Fields-Pane“) 

Kontextmenü des Feldes (in der Fields-Pane) 
> Format-Settings („Format-Pane“) 
> Analytics-Settings („Analytics-Pane“) 

 

Komponente 
„PowerBI.com“  

Account (= Benutzerkonto) 
Tenant (= Mandant) 
 
Datasets (= Queries + Datamodel) 
Reports 
Dashboards 
App-Workspaces 
Apps 
 
Access Control 
Row-Level-Security 
Zeitplanaktualisierung 
Analyze in Excel 

1.4 SHORTCUTS 
Hier finden Sie eine kompakte Übersicht über die für dieses Training nützlichen Shortcuts. 
 

[Strg] + [X]  
[Strg] + [C] 
[Strg] + [V] 

Markierten Zellinhalt in Zwischenablage Ausschneiden 
Markierten Zellinhalt in Zwischenablage Kopieren 
Inhalt der Zwischenablage auf markierte Zelle Einfügen 

[Strg] + [S] Datei Speichern 

[Strg] + [Z] 
[Strg] + [Y] 

letzten Schritt rückgängig machen 
letzten Schritt wiederholen 

1.5 ADRESSIERUNG VON MENÜ- UND TASTATURBEFEHLEN 
Menübefehle werden so dargestellt: 
§ Start -> Options and Settings -> Options 

Das bedeutet: wählen Sie im Menü Start aus der Gruppe Options and Settings den Befehl Options. 
· Kontextmenü des Datenpunkts -> Include 

Das bedeutet: klicken Sie mit der rechten Maustaste auf einen Datenpunkt (in einem Visual) und wählen den Befehl 
Include aus. 

 
Tastaturbefehle werden so dargestellt:  
§ [Strg] und [+] 

Das bedeutet: drücken Sie bei gehaltener „Strg“-Taste zusätzlich die Taste „+“ 
 
Befehle und Objektbezeichnungen werden in diesem Handout immer in fetter Schriftart dargestellt und ausschließlich 
auf die englische Programmversion bezogen.  
 
Hinweis in Klammern 
· „(Power BI Service)“ … bedeutet, daß die Funktion nur im Power BI Service – und nicht in Power BI Desktop – 

verfügbar ist 
· „(Visual Header)“ … bedeutet bspw., daß die Funktion über den Visual Header aufgerufen wird 
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2 WAS IST POWER BI 
 

 
 
Power BI ist im Umkehrschluß kein Tool zum Standardreporting (Druckberichte) und auch kein Tool zur 
Datenerfassung/Planung (Read-Only System). 
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2.1 ARCHITEKTUR VON POWER BI UND FOKUS DIESES TRAININGS 
Power BI besteht aus dem Zusammenspiel von 3 Programmen, die insgesamt 5 Funktionen erfüllen: 
 
Power BI Desktop  ->  1. Get Data (Extraktion, Transformation, Laden) 

 ->  2. Data Model (Analytische Datenbank, Filterbeziehungen, DAX-Funktionen)  
 ->  3. Visualisierung (visuelle Aufbereitung der KPIs, Interaktivität) 

Power BI Service  ->  4. Deployment (24-Stunden Serverbetrieb, Berechtigungen, Aktualisierung) 
Power BI Mobile App  ->  5. Consumption (einfacher Zugang für Management und Information Worker) 
 

 
 
 
 
 
 
 
 
 
 
 
 
Der Fokus dieses Trainings liegt 
auf der Komponente #3 
„Visualisierung“, die anderen 
Stationen werden in diesem 
Training nicht behandelt. 
 
 
 
 
 
 
 
 
 

 

2.2 WAS KOSTET POWER BI? 
Power BI Desktop ist kostenlos, ebenso die Mobile App und das Gateway. Der Power BI Service wird in folgenden 
Lizenzformen angeboten: 
 
1. Power BI Free Account = Beschränkung auf 1-Benutzerbetrieb 
2. Power BI Pro Account = Distribution im Unternehmen 
3. Power BI Premium = Distribution in großen Unternehmen (~ ab 500 User) 
4. Power BI Embedded = Distribution über selbst programmierte Apps und/oder Berichtsportale 
5. Power BI Report Server = Power BI auf eigenen Server im eigenen Netzwerk (ohne Cloud) 
 
Weiterführend: https://powerbi.microsoft.com/de-de/pricing/  
 
Bitte beachten Sie, daß ein regulärer Reportingbetrieb ohne dem Power BI Service – also nur mit Power BI Desktop – 
nicht sinnvoll möglich ist (kein Mehrbenutzerbetrieb, keine Berechtigungen, keine mobile App, keine Druckfunktion, 
keine automatische Datenaktualisierung, usw.). 

  

https://powerbi.microsoft.com/de-de/pricing/
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2.3 POWER BI IM KONTEXT VON EXCEL UND SQL SERVER (MICROSOFT BI STACK) 
Die Microsoft BI Plattform ist eine leistungsfähige und aufgrund des weltweit hohen Verbreitungsgrades kostengünstige 
Business Intelligence Plattform mit einem breiten Leistungsspektrum in Dashboarding, Reporting, Analyse und 
Datawarehousing. Der Ursprung liegt in den sogenannten SQL Server Analysis Services („Cubes“), heute ist Power 
BI das Flaggschiff im BI Portfolio.  
 
Microsoft organisiert die umfangreiche BI Plattform heute in drei großen Produktsäulen, die in der Power BI mobilen 
App, auf PowerBI.com, in Excel Online und im Reporting Services Portal zusammenlaufen: 

 
 
1. Power BI ist das Tool für Dashboarding und mobiles Reporting („Team BI”) 

Power BI Desktop ist ein das Authoring-Tool, die Verteilung der Reports und Dashboards erfolgt über den Cloud 
Service PowerBI.com und den mobilen Apps für iOS, Android und Windows.  

2. Excel ist das Tool für Analyse („Personal BI“) 
Excel ist das leistungsfähige Frontend für Power User Prozesse in der Analyse und in der Praxis vieler Unternehmen 
auch im Management Reporting und in der Planung. Power Pivot ist die leistungsfähige In-Memory Technologie 
zur Erstellung von Mash-ups in der Fachabteilung – Self-Service BI direkt in Excel. 

3. SQL Server ist das Tool für Standardreporting (“Corporate BI”) 
SQL Server ist das leistungsfähige Backend für die Fachabteilungsdaten. Das Datenbankmodul dient als relationales 
Datawarehouse sowie als Steuerungs- und Bereinigungsschicht. Die Analysis Services stellen mit den Tabular 
Models (und den multidimensionalen Cubes) die intelligente und hoch-performante Datamart-Schicht dar. Die 
Reporting Services sind das Tool für das „paginierte Standardreporting“. 

 
Datenmodelle aus Excel Power Pivot können nach Power BI Desktop, nach PowerBI.com und auch nach SQL Server 
Tabular Model importiert werden. Das Know-How aus Power Pivot inkl. der DAX-Formelsprache kann 1:1 in Power BI 
Desktop und in SQL Server Tabular Model angewendet werden. Es handelt sich also um 1 Technologie, die in 3 Produkten 
verbaut ist (analog wie Power Query). 
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3.2 AUFBAU VON POWER BI DESKTOP 

3.2.1 USER INTERFACE VON POWER BI DESKTOP 
Das User Interface kann aus der Perspektive der 3 zentralen Komponenten strukturiert werden: 
1. Get Data / Queries („orange“) 
2. Datamodel („blau“) 
3. Visualisierung („grün“) 
 

 
Weiterführend: https://docs.microsoft.com/en-us/power-bi/service-the-report-editor-take-a-tour  
 
Der Fokus dieses Trainings liegt auf der Visualisierung. Das Datamodel bildet das Fundament für sämtliche 
Visualisierungen, wird aber in diesem Training nicht aktiv behandelt sondern lediglich der Import aus Power Pivot / 
Power Query verwendet (bzw. mit fertigen Trainingscases gearbeitet). Die Query-Komponente wird in diesem Training 
gar nicht behandelt. 
 
 
  

https://docs.microsoft.com/en-us/power-bi/service-the-report-editor-take-a-tour
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3.2.2 DATEI – DATASET – PAGE – OBJEKT 
1 PBIX-Datei = 1 Anwendung im Power BI Service (Dataset und Reports können optional getrennt werden) 

└ Pro Anwendung 1 oder mehrere Pages = Canvas („weiße Fläche“) 
└ Pro Page 1 oder mehrere Objekte = Visuals und/oder Textboxen, Images, Shapes 
 

 

3.3 BASISVISUALISIERUNGEN IN POWER BI ERSTELLEN 
In diesem Kapitel werden die ersten Visuals erstellt, die Typänderung und die Größenanpassung geübt sowie die 
Feldbelegung und auf einem Einsteigerlevel behandelt. Die Settings der Visuals werden hier noch nicht behandelt. 
Nach dem Import der Power Pivot Anwendung wurde im Bereich Report eine Berichtsseite (Page) angelegt mit einem 
vorerst noch leerem Visualisierungsbereich (Canvas, „weiße Fläche“): 

 
  



 

 

 

(Preview-Dokument … Kapitel ausgeblendet) 
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3.4.2 FARBSCHEMA 
Das Standard-Farbenschema in Power BI ist „speziell“, aus betriebswirtschaftlicher Sicht fehlen vor allem die rote und 
grüne Farbe für die Visualisierung für „negativ“ und „positiv“: 

 
 
Die sogenannten Custom Color Themes sind zum Stand 2018.04 noch ein Preview-Feature, das unter File -> Options 
& Settings -> Options -> Global -> Preview Features aktiviert werden muß. Ist das geschehen, kann die in den 
Trainingsunterlagen mitgelieferte Datei 
 

> PowerBI-LINEARIS-Color-Theme.json 
 
mit dem Befehl Home -> Switch Theme -> Import Theme eingelesen werden … 

 
 
… und dann folgendes Farbschema nutzen: 

 
 
Weiterführende Informationen: 
> Zahlreiche Report Themes gibt es in der Power BI Themes Gallery zur Auswahl: 

https://community.powerbi.com/t5/Themes-Gallery/bd-p/ThemesGallery 
> Eine eigene JSON-Datei kann mit dem Report Theme Generator (nicht von Microsoft sondern aus der Community) 

erstellt werden: 
Erklärung: https://exceleratorbi.com.au/changing-defaults-in-power-bi   
Tool: https://powerbi.tips/tools/report-theme-generator-v3  
 

  

https://community.powerbi.com/t5/Themes-Gallery/bd-p/ThemesGallery
https://exceleratorbi.com.au/changing-defaults-in-power-bi
https://powerbi.tips/tools/report-theme-generator-v3
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4.5.4 WATERFALL (STANDARD VISUAL) 
Ausgangssituation: Actual 2017 = 92,3 M | Actual 2016 = 82,4 M | Variance ACT-LY = 9,9 M 
> Waterfall auf ACTUALS 

 
Kritische Würdigung: 
· Nette Darstellung mit wenig Nutzen; es werden keine Abweichungen visualisiert sondern ähnlich einem Column 

Chart werden Monatswerte in Treppenform visualisiert mit einer zusätzlichen Jahressumme. 
 

> Waterfall auf die ACT-BUD Variance 

 
Kritische Würdigung: 
· Die linke Darstellung zeigt Monatsabweichung (gg. Plan) in Treppenform und erzeugt dabei zwangsweise den 

Eindruck einer kumulierten Betrachtung, was es aber nicht ist. Für die richtige Lesart müßten die Dashboard-
Konsumenten gründlich geschult werden (was nicht dem Zweck einer Dashboard-Anwendung entspricht). Hat 
aber den Vorteil, daß die Gesamtabweichung als Total-Balken klar erkennbar dargestellt ist (wenn auch eine 
solche Darstellungsform gewöhnungsbedürftig wäre und noch rot-/grün eingefärbt werden müsste). 

· Die rechte Darstellung zeigt eine echte Kumulationstreppe mit einer wertvollen Informationskette bis zum 
Dezember. Die Visualisierung leidet aber daran, daß ein Total-Balken von 0,2M ermittelt wird, der keinerlei 
Relevanz hat und vermutlich auch nicht deaktiviert werden kann (die -2,6M im Dezember sind die 
Jahresabweichung).  

· Mit dem Variance-Measure also kann mit dem Waterfall Standard Visual leider kein „richtiger“ Waterfall für 
diesen Anwendungszweck erreicht werden, in dem ausgehend vom Vorjahreswert über die Variances auf den 
laufenden (Jahres-)Wert übergleitet werden könnte. Stattdessen ist nur eine „Treppe“ der Variances 
darstellbar. Wir empfehlen daher, den Waterfall für diesen Anwendungsfall nicht zu verwenden. 
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> Waterfall auf ACTUALS unter Nutzung der Breakdown-Funktion 

   
Kritische Würdigung: 
· Grundsätzlich sehr gute Darstellung (automatische Ermittlung der Variances pro Periode) 
· Schwierig zu handhaben ist die Filterung auf 2 Jahresperioden (da in den meisten Dashboards nur 1 Jahr 

selektiert wird -> ggfs. DAX-basierte Lösung möglich) 
· Problematisch ist die abgeschnittene Y-Achse (irreführende Skalierung, kann aber auf den Startwert = 0 

gesetzt werden und dann die Y-Achse wieder ausgeblendet werden) 
· Problematisch ist die automatische (und vermutlich nicht veränderbare) Sortierung nach Werten anstatt nach 

Monaten  
 
Die Breakdown-Funktion ist vermutlich weniger für den Aufriss nach Perioden sondern nach anderen Attributen 
gedacht: 

 
Quelle: https://insightsquest.com/2017/11/30/waterfall-chart-breakdown/  
 

Leider ist das Waterfall Standard Visual insgesamt nicht besonders leistungsfähig, siehe hier im direkten Vergleich mit 
dem Ultimate Waterfall Custom Visual: 
https://www.linearis.at/blog/2017/09/01/waterfall-visuals-in-power-bi-standard-vs-ultimate/ 
 

  

https://insightsquest.com/2017/11/30/waterfall-chart-breakdown/
https://www.linearis.at/blog/2017/09/01/waterfall-visuals-in-power-bi-standard-vs-ultimate/
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6.2 INTERAKTIONEN KONFIGURIEREN 

6.2.1 CROSSFILTER-INTERAKTIONEN 
Mit der Funktion Visual Tools -> Format -> Edit Interactions können die Crossfilter-Interaktionen zwischen den 
Visuals definiert werden.  

 
 
Dabei wird ein bestimmtes Visual markiert (hier: die Map) und dann über das Crossfilter-Menü der 
anderen Visuals die Filterbeziehung in den folgenden (bis zu) 3 Modi konfiguriert: 
> Filter-Modus … das Visual wird auf den gefilterten Betrag angepaßt -> immer dann sinnvoll, wenn durch 

Filterungen im Highlighting-Modus nur noch verschwindend kleine Werte übrigbleiben würden 
> Highlighting-Modus … bei der Filterung wird die Gesamtsumme als „ausgegrauter“ Balken usw. weiterhin 

dargestellt und der gefilterte Betrag als „davon“-Information dargestellt 
> Kein Filter … wird dann benötigt, wenn die Filterung zu nutzlosen Ergebnissen führt -> bspw. ein Monats-Slicer 

soll nicht die 12-Monats-Grafik filtern, die einzelne Zeile eines Tables braucht nicht die anderen Charts auf minimale 
Werte zu filtern, usw. 

 

6.2.2 DRILLDOWN-INTERAKTIONEN 
Die Wirkung des Drilldowns in einem Visual auf die anderen Visuals der gleichen Page kann mit dieser Funktion 
konfiguriert werden (= Setting auf Visual-Ebene):  
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7 VERTIEFUNG: DATAMODEL-FUNKTIONEN ZUR 
VISUALISIERUNG 

7.1  (DAX-)WIZARDS 
Die DAX Wizards bauen Calculated Columns oder Measures auf, die vom User keinerlei Kenntnisse der DAX-
Formelsprache voraussetzen. Die automatisch generierten DAX-Formeln sind teilweise einsehbar (Quick Measures). 

7.1.1 AUTO DATE/TIME DIMENSION (DATAMODEL) 
> Aktivierung unter Datei -> Options & Settings -> Options -> Current File -> Data Load: 

 
> Konsequenz: Jedes Feld vom Datentyp Datum, das in keiner Beziehung verwendet wird, erhält automatisch eine 

4-stufige Hierarchie bestehen aus Year, Quarter, Month und Day: 

 
> Der Aufbau der 4 Hierarchiefelder kann nicht verändert werden und sieht immer so aus: 

 
> Beim Aktivieren eines Datumsfeldes wird automatisch die 4-stufige Hierarchie verwendet, soll nur das Datum 

verwendet (wie im Table oben in der 1. Spalte), dann kann über das Feld-Kontextmenü zwischen den beiden 
Darstellungsvarianten umgeschalten werden: 

 
 
  



 

 

 

(Preview-Dokument … Kapitel ausgeblendet) 


